
Getting Started Guide
Pour Démarrer

Erste Schritte
Para Comenzar



SmarTerm 2014 - Version 15.0.0 Issued October 2013
Copyright © 1983-2013 Esker S.A. All rights reserved.

Copyright © 1991-2001 Microsoft Corporation.
Copyright © 1992-1999 Summit Software Company.
Copyright © 1998-2011 The OpenSSL Project. All rights reserved.
Copyright © 1995-1998 Eric Young (eay@cryptsoft.com). All rights reserved.
Copyright © 1995-1998 Tim Hudson (tjh@cryptsoft.com). All rights reserved.
Copyright © 1995-2005 The Cryptix Foundation Limited. All rights reserved.
Copyright © 1995 Tatu Ylonen <ylo@cs.hut.fi> Espoo, Finland. All rights reserved.
Copyright © 1998 CORE SDI S.A., Buenos Aires, Argentina. All rights reserved.
Copyright © 1983, 1990, 1992, 1993, 1995 The Regents of the University of California. All rights reserved.
Copyright © 1995, 1996 by David Mazieres dm@lcs.mit.edu.
Copyright © 1995-2004 Jean-Loup Gailly and Mark Adler.
For additional information, conditions of use, and disclaimers, see copyright.pdf file.
Use and duplicate only in accordance with the Software License Agreement: SmarTerm Products.

Esker, the Esker logo, Esker Pro and SmarTerm, are registered trademarks of Esker S.A or Esker, Inc. DEC, VT, LAT, and VAX are
registered trademarks of Compaq Computer Corporation. IBM and PC AT are registered trademarks of International Business Machines
Corporation. Microsoft, Windows, and Active Server are registered trademarks of Microsoft Corporation. Novell is a registered trademark
of Novell, Inc. Netscape and Netscape Navigator are registered trademarks of Netscape Communications Corporation. UNIX is a
registered trademark of The Open Group.
All other brand and product names are or may be trademarks, registered trademarks, or service marks of, and are used to identify products
or services of, and is the property of, their respective owners.

Information in this document is subject to change without notice.

See the list of Esker locations in the world.

No part of this document may be reproduced or transmitted in any form or by any means without the prior written consent of Esker S.A. For the
Americas: printed in the United States of America. For the rest of the world: printed in France.

http://www.esker.com/contact_us.asp
http://www.esker.com/contact_us.asp
http://www.esker.com/contact_us.asp
http://www.esker.com/contact_us.asp
http://www.esker.com/contact_us.asp
http://www.esker.com/contact_us.asp
http://www.esker.com/contact_us.asp
http://www.esker.com/contact_us.asp
http://www.esker.com/contact_us.asp


Contents
English version 5

Preface 5
Information and technical support 5

Installing SmarTerm 6
Installation requirements 6
Before you install 6

Have your serial number handy 6
Shut down extra Windows programs 6
Multilingual options 7
Installation type 7

Run setup 7
Upgrading SmarTerm from an evaluation copy to a licensed copy 8
Updating custom files from older versions of SmarTerm 8

Updating session (.STW) files 8
Updating keyboard (.KBO) files 9

What to do next 9

Deutsche Version 10

Vorwort 10
Auskunft und technischer Kundendienst 10

Installation von SmarTerm 11
Installationsvoraussetzungen 11
Bevor Sie installieren 11

Halten Sie Ihre Seriennummer bereit 11
Fahren Sie andere Windows-Programme herunter 12
Mehrsprachige Optionen 12
Installationstyp 12

Setup ausführen 12
SmarTerm von der Evaluierungsversion auf die lizenzierte Version aktualisieren 13
Aktualisieren selbstdefinierter Dateien aus früheren Versionen 13

Sitzungsdateien (.STW) aktualisieren 13
Tastaturdateien (.KBO) aktualisieren 14

Weiterführende Informationen 14



Version française 15

Préface 15
Support technique et informations 15

Installation de SmarTerm 16
Configuration requise 16
Avant l’installation 16

Ayez votre numéro de série à portée de main 16
Quittez tous les autres programmes Windows 17
Options multilingues 17
Type d’installation 17

Exécution du programme d’installation 17
Actualiser SmarTerm de la version d'évaluation à la version sous licence 18
Mettre à jour les fichiers personnalisés 18

Mettre à jour les fichiers de session (.STW) 18
Mettre à jour les fichiers de clavier (.KBO) 19

Que faire ensuite ? 19

Version espagnola 20

Prefacio 20
Información y apoyo técnico 20

Instalación de SmarTerm 21
Requisitos de instalación 21
Antes de la instalación 21

Tenga a mano su número de serie 21
Cierre de programas Windows adicionales 22
Opciones multilingües 22
Tipo de instalación 22

Ejecución del programa de instalación 22
Actualización de SmarTerm desde una copia de evaluación hasta una copia con licencia 23
Actualización de archivos personalizados de versiones anteriores 23

Actualización de los archivos de sesión (.STW) 23
Actualización de los archivos de teclado (.KBO) 24

El paso siguiente 24



English version

Preface
This Getting Started guide will help you install SmarTerm on your PC. This guide, in combination
with the more detailed online help system, and with online manuals, provides you with what you need
to use SmarTerm.

This guide provides instructions for installing SmarTerm in the language of your choice—English,
French, German, or Spanish—and provides an overview of installation. After reading this Preface, turn
to “Installing SmarTerm” for instructions on running Setup.

For information on the Administrator Toolbox, including creating profiles and profile servers or
deploying SmarTerm for network users, see the System Administrator Guide (English only).

Information and technical support
If you encounter problems with SmarTerm, check through the troubleshooting hints in the online help
and SmarTerm documentation. Many situations are common and can be corrected easily with the
suggestions given there. If your problems persist, call Esker’s Technical Support department for
assistance.

Before you call for technical support:

• Know your license number. It’s on the Registration card that comes with your product. (If you
entered the number during installation, you can display this license number by selecting Help >
About.)

• Be aware that we may need detailed information about the hardware and software on your
computer, so a working knowledge of Windows, the setup of your PC, and the way you are using
SmarTerm may be necessary.

• Isolate the problem as much as possible. Does the problem occur every time you enter a certain
sequence of keystrokes, or do you have to do something else first? Writing down a short description
of the steps it takes to repeat the problem will help both of us to isolate the problem.

• Seat yourself at the PC that is giving you trouble and call us from there. We may need to have you
run one or more diagnostic tests, and these must be done on the computer with the problem.
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Installing SmarTerm

SmarTerm is an integrated set of Windows applications that put you online with the most popular
connectivity methods in use today. SmarTerm is a multilingual product, operating in your choice of
English, French, German, or Spanish, while allowing you to change languages without disconnecting
from your host or exiting SmarTerm.

This chapter steps through the installation of SmarTerm.

Installation requirements
SmarTerm runs on any system that has the following hardware and software:

• Windows 7 32-bit or 64-bit/Windows 8 or 8.1 32-bit or 64-bit/Windows Server 2008 R2/Windows
Server 2012 or 2012 R2, with the latest Service Packs installed.

• The minimum computer hardware that is required by the operating system.

• 128 MB of memory minimum.

• Screen resolution set to at least 800 x 600 with 256 colors.

• Appropriate communication hardware and software, such as a serial port or modem, if you intend to
use a direct serial connection or a modem connection.

• The Windows TCP/IP stack if you intend to use the Telnet connection method or FTP.

• Microsoft Host Integration client if you intend to use this connection method.

• Adobe® Reader to read the manuals. You can download this software from the Adobe web site.

• 60 MB of available disk space to install all components and languages.

Before you install
Below are some things you should know about before you install SmarTerm. Read through the next
sections to see if there are any steps you need to take before running Setup to install SmarTerm.

Have your serial number handy
Setup prompts you for your name, your serial number and your activation key for the product your
purchased. (To display your serial number after installation, simply select Help > About.) You must
register SmarTerm to obtain a serial number.

Shut down extra Windows programs
To make installation go as smoothly as possible, shut down any programs running in the background,
such as:

• Applications

http://get.adobe.com/reader/
http://get.adobe.com/reader/
http://get.adobe.com/reader/
http://get.adobe.com/reader/
http://get.adobe.com/reader/
http://get.adobe.com/reader/
http://get.adobe.com/reader/
http://get.adobe.com/reader/
http://get.adobe.com/reader/
http://get.adobe.com/reader/
http://get.adobe.com/reader/
http://get.adobe.com/reader/
http://get.adobe.com/reader/
http://www.adobe.com/support/downloads/product.jsp?product=ac&platform=win
http://www.adobe.com/support/downloads/product.jsp?product=ac&platform=win
http://www.adobe.com/support/downloads/product.jsp?product=ac&platform=win
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• Virus protection programs

Multilingual options
You can run Setup in English, French, German, or Spanish. The language you choose for Setup
becomes the default language the first time you run SmarTerm.

Note:
Setup will always install English components, but you can install French, German, and Spanish
components as well. Whatever languages you choose to install are available to you in any session you
use to connect to a host. Language switching is dynamic, meaning that you can start a session in
French and switch to German without disconnecting from the host or exiting SmarTerm. Language
changes affect the menus and dialogs. The online help is provided in English only.

Installation type
You can choose between two types of installation: Complete and Custom. Complete installs all the
features of SmarTerm except the Administrator Toolbox, and is recommended for a first-time
installation. Custom allows you to choose the SmarTerm components that you want to install.

Note:
If you want to install the Administrator Toolbox, you must choose Custom and then select
Administrator Tools to install the Administrator Toolbox.
To install SmarTerm to a path other than the default, choose Custom installation and click the Change
button. Then enter the path you want.

Run setup
Follow the steps below to run Setup:

1. Insert the CD into the CD-ROM drive and choose Install SmarTerm from the CD browser window.

Note:
If the “autorun” feature is disabled or unavailable, run autorun.exe from the root directory of the CD.

2. Select the language for the installation program.
3. Follow the prompts Setup presents to you.

If you don’t like the defaults, type in new values or select a value from the list boxes or check boxes
on a dialog. If you are unsure of the appropriate response to a prompt, consult the online help for
detailed information about your choices or simply accept the defaults.

Notes:
Configuration files are saved on a per-user basis in that user's documents and settings location.
The required Esker Licensing Service tracks the number of instances of SmarTerm running on a
network. It does this by broadcasting license information every 15 minutes, via UDP port 47474.
To display advanced setup settings, launch Smarterm.exe with the ADVANCEDSETUP=1 option
(refer to System Administrator Guide). This allows you to specify if the users share a common file
location and/or to enter a profile server.
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Upgrading SmarTerm from an evaluation copy to a
licensed copy
Once you purchase a copy of SmarTerm from Esker Sales or your reseller, you can use the Esker
Licensing Administration utility to upgrade an evaluation copy of SmarTerm to a licensed copy.

1. Select Start > Programs > SmarTerm > Utilities > Esker Licensing Administration.
2. Highlight the SmarTerm product you want to upgrade.

3. Click the Modify the serilization info button .
4. Enter the new Serial number and Activation key and click OK.

You may now run your licensed copy of SmarTerm.

Updating custom files from older versions of
SmarTerm
You can use custom files that you’ve created using a version 6.0 SmarTerm product or greater with
this new version of SmarTerm. These files include session configuration (.STW), keyboard (.KBO), and
script language (.PSL). Custom files from version 7.0 SmarTerm or greater are all set for use with this
version—there is no file conversion required. Just use the files as you did in those versions of
SmarTerm. There are certain rules that you should keep in mind when updating custom files:

• Keep an archive of all your old files. This means backing up the files to a network server location
or backing up to a diskette. SmarTerm creates backups for some files, but it’s best to keep your own
copies, should you ever want to use the older files again.

• Conversions are done locally on a PC. If you plan to make the converted files available to network
users, you can test locally and copy them to a folder on the network server.

• Most conversions are done automatically but you need to copy the older files to the correct default
file locations.

Updating session (.STW) files
1. Start up SmarTerm, if you do not already have it running.
2. Pull down the File menu.

A list of available .STW files appears.

3. Select an .STW. As soon as you select it, it is converted.
Once the list appears, you have converted all your session files. During conversion, SmarTerm makes a
copy of the original .STW files and changes the extension to .BAK. Converted files are written out as
.STW files.

Note:
After you have tested the new session files to see if the conversion was successful, you may want to
remove the .BAK files, which are no longer used by SmarTerm.

Things to keep in mind
If the old .STW file used a login script (.psl), it is converted to the new macro language and embedded
in the new session file. (Remember that .psl files need to be in the \Macros folder.)
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If the old .STW file connected through a modem to a host, it is converted to use the Direct Serial
connection type. You will have to create a new .STW file for use with a modem. (SmarTerm uses
Microsoft's TAPI interface for Windows.)

The settings in the Preferences dialog in the pre-version 6.0 products are not converted into the new
.STW format.

Updating keyboard (.KBO) files
Note:
If you are converting TN3270 Addition keyboard map files, you need to rename the .KB2 extension to
.KBO before converting to the new SmarTerm format.

1. Start up SmarTerm, if you do not already have it running.
2. Select Tools > Keyboard Maps.

A list of available keyboard maps and the old .KBO files appears.

3. Select a keyboard map file, and click Edit.
4. Select File > Save.

Once you save the old .KBO file, it is converted to the new format. During conversion, SmarTerm
makes a copy of the original .KBO files and changes the extension to .BAK. Converted files are
written out as .KBO files.

Note:
After you have tested the new keyboard maps to see if the conversion was successful, you may want
to remove the .BAK files, which are no longer used by SmarTerm.

What to do next
For information on the Administrator Toolbox, including creating profiles and profile servers or
deploying SmarTerm for network users, see the System Administrator Guide (English only).



Deutsche Version

Vorwort
Dieses Handbuch Erste Schritte ist Ihnen bei der Installation von SmarTerm auf dem PC. Es enthält, in
Kombination mit dem ausführlicheren Online-Hilfeystem und den Online-Handbüchern, alle
Informationen, die Sie für die Verwendung von SmarTerm benötigen.

Die in diesem Handbuch enthaltene Anleitung zur Installation von SmarTerm ist in vier Sprachen
verfügbar – Englisch, Französisch, Deutsch und Spanisch – und bietet einen Überblick über den
Installationsvorgang. Anweisungen zur Ausführung des Setup-Programms finden Sie unter “Installation
von SmarTerm”.

Informationen über die Administrator Toolbox, sowie über das Erstellen von Profilen und Profilservern,
das Ausführen des Installationsassistenten oder den Einsatz von SmarTerm in einem Netzwerk finden
Sie im System Administrator Guide (nur auf Englisch erhältlich).

Auskunft und technischer Kundendienst
Wenn Sie auf Probleme mit SmarTerm stoßen, gehen Sie bitte zuerst in der Online-Hilfe und
SmarTerm-Dokumentation durch. Sollten Ihre Probleme weiter bestehen und Sie Hilfestellung
benötigen, wenden Sie sich an die technische Kundendienstabteilung von Esker.

Bevor Sie den technischen Kundendienst anrufen:

• Halten Sie Ihre Lizenznummer bereit. Sie befindet sich auf der Registrierungskarte, die Ihrem
Produkt beigelegt ist. (Wenn Sie diese Lizenznummer während der Installation eingegeben haben,
können Sie sie mit dem Befehl "Info" im Menü "Hilfe" anzeigen.)

• Unter Umständen benötigen wir detaillierte Informationen zur Hardware und Software auf Ihrem
Computer. Es ist deshalb hilfreich, wenn Sie mit der Verwendung von Windows, der Konfiguration
Ihres PCs und Ihrer spezifischen Benutzung von SmarTerm vetraut sind bzw. Auskunft darüber
geben können.

• Isolieren Sie das Problem so weit wie möglich. Tritt das Problem jedes Mal auf, wenn Sie eine
bestimmte Tastenfolge ausführen, oder müssen Sie zuerst einen anderen Vorgang durchführen? Das
Problem kann leichter isoliert werden, wenn Sie die einzelnen Schritte zum Nachvollziehen des
Fehlers kurz schriftlich festhalten.

• Begeben Sie sich zu dem PC, der Ihnen Schwierigkeiten bereitet, und rufen Sie uns von da aus an.
Eventuell müssen Sie einen oder mehrere Diagnosetests für uns durchführen, die nur auf dem
Computer mit dem Problem ausgeführt werden können.
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Installation von SmarTerm

SmarTerm besteht aus einer Reihe von Windows-Anwendungen, mit denen Sie Online-Verbindungen
über die heute gängigsten Verbindungsmethoden herstellen können. SmarTerm ist ein mehrsprachiges
Produkt, das Ihnen die Wahl zwischen einer englischen, französischen, deutschen und spanischen
Oberfläche bietet, zwischen denen Sie wechseln können, ohne die Verbindung zum Host abbrechen
oder SmarTerm beenden zu müssen.

Dieses Kapitel führt Sie schrittweise durch die Installation von SmarTerm.

Installationsvoraussetzungen
SmarTerm kann auf jedem System mit folgender Hardware und Software betrieben werden:

• Windows 7 32-Bit oder 64-Bit/Windows 8 oder 8.1 32-Bit oder 64-Bit/Windows Server 2008
R2/Windows Server 2012 oder 2012 R2, mit den neusten Service-Packs installiert.

• Den Mindestanforderungen an Hardware, die für das Betriebsystem erforderlich sind.

• 128 MB an RAM.

• Bildschirmauflösung von mindestens 800 x 600 mit 256 Farben.

• Entsprechender Kommunikationshardware und -software, wie ein serieller Anschluß oder ein
Modem, wenn Sie eine direkte serielle oder eine Modemverbindung verwenden wollen.

• Dem TCP/IP-Stapel von Windows, wenn Sie das Telnet-Verbindungsverfahren oder FTP verwenden
wollen.

• Microsoft Host Integration-Client wenn Sie diese Verbindungsmethode verwenden wollen.

• Adobe® Reader um die Online-Handbücher zu lesen. Sie können diese Software von der Adobe-
Website herunterladen.

• 60 MB an freiem Festplattenspeicherplatz, um alle Komponenten und Sprachen.

Bevor Sie installieren
Lesen Sie sich die nächsten Abschnitte durch, um festzustellen, ob Sie vor dem Ausführen des Setup-
Programms zur Installation von SmarTerm noch einige Schritte durchführen müssen.

Halten Sie Ihre Seriennummer bereit
Setup fordert zur Eingabe Ihres Namens, der Seriennummer und des Aktivie-rungsschlüssels für das
gekaufte Produkt auf. (Nach der Installation können Sie Ihre Seriennummer anzeigen lassen, indem Sie
auf Hilfe>Info klicken.) Sie müssen SmarTerm registrieren, um eine Seriennummer zu erhalten.

http://get.adobe.com/reader/
http://get.adobe.com/reader/
http://get.adobe.com/reader/
http://get.adobe.com/reader/
http://get.adobe.com/reader/
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http://get.adobe.com/reader/
http://get.adobe.com/reader/
http://get.adobe.com/reader/
http://get.adobe.com/reader/
http://get.adobe.com/reader/
http://get.adobe.com/reader/
http://get.adobe.com/reader/
http://get.adobe.com/reader/
http://get.adobe.com/reader/
http://get.adobe.com/reader/
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Fahren Sie andere Windows-Programme herunter
Damit der Installationsvorgang so reibungslos wie möglich verlaufen kann, beenden Sie alle im
Hintergrund laufende Programme, wie:

• Anwendungen

• Virenschutzprogramme

Mehrsprachige Optionen
Sie können das Setup-Progamm auf Englisch, Französisch, Deutsch und Spanisch ausführen. Die für
das Setup gewählte Sprache wird zur Standardsprache, wenn Sie SmarTerm zum ersten Mal starten.

Das Setup-Programm installiert immer die englischen Komponenten; Sie können jedoch zusätzlich
französische, deutsche und spanische Komponenten installieren. Alle installierten Sprachen stehen
Ihnen auch in jeder Sitzung zur Verfügung, mit der Sie eine Hostverbindung herstellen. Des Wechseln
der Sprache geschieht auf dynamische Weise, was bedeutet, daß Sie eine Sitzung auf Französisch
beginnen und dann auf Deutsch weiterführen können, ohne die Hostverbindung oder SmarTerm zu
beenden. Sprachwechsel wirken sich auf die Menüs und Dialogfelder aus. Die Online-Hilfe ist nur auf
Englisch erhältlich.

Installationstyp
Sie haben die Wahl zwischen zwei Installationsarten: "Vollständig" und "Selbstdefiniert". Vollständig
installiert alle Funktionen von SmarTerm außer der Administrator Toolbox und wird bei einer
erstmaligen Installation empfohlen. Selbstdefiniert ermöglicht es Ihnen, die gewünschten SmarTerm-
Komponenten auszuwählen.

Hinweis:
Sollten Sie die Administrator Toolbox installieren wollen, müssen Sie Selbstdefiniert und dann
Administrator Tools auswählen, um daraufhin die Administrator Toolbox zu installieren.
Wollen Sie SmarTerm in einem anderen Pfad als dem standardmäßig angegebenem installieren, wählen
Sie Selbstdefiniert und klicken Sie auf die Schaltfläche Ändern. Geben Sie dann den von Ihnen
gewünschten Pfad ein.

Setup ausführen
Führen Sie das Setup-Programm mit den folgenden Schritten aus:

1. Legen Sie die CD in das CD-ROM-Laufwerk ein, und wählen Sie im CD-Browser-Fenster “Install
SmarTerm”.

Hinweis:
Ist die Funktion “autorun” deaktiviert oder nicht verfügbar, führen Sie autorun.exe aus dem
Stammverzeichnis der CD aus.

2. Wählen Sie die Sprache für das Installationsprogramm aus.
3. Folgen Sie den Eingabeaufforderungen des Setup-Programms.

Wenn Sie in einem beliebigen Dialogfeld die Standardwerte nicht verwenden wollen, geben Sie neue
Werte ein, oder wählen Sie einen Wert über die Felder oder Kontrollkästchen in einem Dialogfeld aus.
Wenn Sie die entsprechende Antwort auf eine Eingabeaufforderung nicht wissen, können Sie
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detaillierte Informationen zu den Auswahlmöglichkeiten über die Online-Hilfe abrufen oder einfach
die Standardwerte übernehmen.

Hinweis:
Die Konfigurierungsdateien werden für jeden Benutzer unter “Dokumente und Einstellungen” für den
jeweiligen Benutzer gespeichert.
Der benötigte Esker Licensing Service zählt mit, wie oft SmarTerm auf dem Netzwerk ausgeführt wird.
Dies geschieht, indem die Lizenzinformationen alle 15 Minuten über den UDP-Port 47474
rundgesendet werden.
Um die erweiterten Setup-Einstellungen anzuzeigen, starten Sie Smarterm.exe mit der Option
ADVANCEDSETUP=1 (siehe System Administrator Guide). Damit können Sie es bestimmen, ob die
Benutzer einen gemeinsamen Speicherort und/oder einen Profil-Server nutzen.

SmarTerm von der Evaluierungsversion auf die
lizenzierte Version aktualisieren
Sobald Sie eine Version von of SmarTerm von Esker Sales oder Ihrem Händler gekauft haben, können
Sie das Esker Lizenzierungsverwaltungs-Dienstprogramm zum Aktualisieren Ihrer Evaluierungsversion
von SmarTerm auf die lizenzierte Version verwenden.

1. Wählen Sie Start > Programme > SmarTerm > Dienstprogramme > Esker Lizenzierungsverwaltung.
2. Markieren Sie das SmarTerm-Produkt, das Sie aktualisieren möchten.
3. Klicken Sie auf die Schaltfläche “Serialisierungsinfo ändern” .
4. Geben Sie die neue Seriennummer und den Aktivierungsschlüssel ein und klicken Sie auf “OK”.

Nun können Sie die lizenzierte Version von SmarTerm ausführen.

Aktualisieren selbstdefinierter Dateien aus früheren
Versionen
Sie können selbstdefinierte Dateien, die Sie mit einem SmarTerm-Programm der Version 6.0 oder höher
erstellt haben, auch mit dieser neuen Version von SmarTerm verwenden. Selbstdefinierte Dateien der
Version 7.0 SmarTerm oder höher können alle mit dieser Version verwendet werden — eine
Dateikonvertierung ist nicht erforderlich. Beim Aktualisieren von selbtsdefinierten Dateien sollten Sie
bestimmte Regeln beachten:

• Archivieren Sie alle Ihre alten Dateien, d.h., erstellen Sie Sicherungskopien der Dateien auf einem
Netzwerkserver oder auf Diskette. SmarTerm erstellt zwar Sicherungskopien für einige Dateien, Sie
sollten jedoch Ihre eigenen Kopien für den Fall aufbewahren, daß Sie die alten Dateien nochmals
verwenden wollen.

• Konvertierungen werden lokal auf einem PC durchgeführt. Wenn Sie die konvertierten Dateien für
Netzwerkanwender bereitstellen wollen, können Sie sie lokal testen und dann in einem Ordner auf
dem Netzwerkserver kopieren.

• Die meisten Konvertierungen erfolgen automatisch, Sie müssen jedoch die älteren Dateien in die
korrekten Standarddateispeicherorte kopieren.

Sitzungsdateien (.STW) aktualisieren
1. Starten Sie SmarTerm, falls dies nicht bereits geschehen ist.
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2. Öffnen Sie das Menü "Datei".
Eine Liste mit verfügbaren .STW-Dateien wird angezeigt.

3. Wählen Sie eine .STW-Datei aus. Sobald Sie sie auswählen, wird die Datei konvertiert.
Wenn die Liste erscheint, haben Sie alle Ihre Sitzungsdateien konvertiert. Während der Konvertierung
erstellt SmarTerm eine Kopie der originalen .STW-Dateien und ändert die Erweiterung zu .BAK.
Konvertierte Dateien werden als .STW-Dateien ausgeschrieben.

Hinweis:
Nachdem Sie die neuen Sitzungsdateien getestet haben, um festzustellen, ob die Konvertierung korrekt
durchgeführt wurde, können Sie die .BAK-Dateien, die nun von SmarTerm nicht mehr verwendet
werden, entfernen.

Wichtige Hinweise
Wenn in der alten .STW-Datei ein Login-Skript (.psl) verwendet wurde, wird dieses in die neue
Makrosprache konvertiert und in die neue Sitzungsdatei eingebettet. (Denken Sie daran, daß sich .PSL-
Dateien im Ordner MACROS befinden müssen.)

Wenn eine .STW-Datei über ein Modem mit einem Host verbunden war, wird sie in den direkten
seriellen Verbindungstyp konvertiert. Sie müssen eine neue .STW-Datei zur Verwendung mit einem
Modem erstellen. (SmarTerm verwendet nun Microsofts TAPI-Schnittstelle für Windows.)

Die Einstellungen im Dialogfeld "Voreinstellungen" in Produkten vor Version 6.0 werden nicht in das
neue .STW-Format konvertiert.

Tastaturdateien (.KBO) aktualisieren
Hinweis:
Wenn Sie TN 3270 Addition-Tastaturzuordnungsdateien konvertieren, müssen Sie die .KB2-
Erweiterung zu .KBO ändern, bevor Sie sie in das Format von SmarTerm 8.0 konvertieren.

1. Starten Sie SmarTerm, falls dies nicht bereits geschehen ist.
2. Wählen Sie Tools> Tastaturbelegungen.

Eine Liste der verfügbaren Tastaturbelegungen und der alten .KBO-Dateien wird angezeigt.

3. Wählen Sie eine Tastaturbelegungsdatei aus, und klicken Sie auf "Bearbeiten".
4. Wählen Sie Datei> Speichern.

Sobald Sie die alte .KBO-Datei speichern, wird sie in das Format der Version 8.0 konvertiert. Während
der Konvertierung erstellt SmarTerm eine Kopie der originalen .KBO-Dateien und ändert die
Erweiterung zu .BAK. Konvertierte Dateien werden als .KBO-Dateien ausgeschrieben.

Hinweis:
Wenn Sie die neuen Tastaturbelegungen auf erfolgreiche Konvertierung geprüft haben, können Sie die
.BAK-Dateien entfernen, da diese von SmarTerm nicht mehr verwendet werden.

Weiterführende Informationen
Informationen über die Installation der Administrator Toolbox, das Erstellen von Profilen und
Profilservern oder den Einsatz von SmarTerm in einem Netzwerk finden Sie im System Administrator
Guide (nur auf Englisch erhältlich).



Version française

Préface
Ce guide Pour Démarrer vous aide à installer SmarTerm sur votre PC. Consulté en complément de
l’aide en ligne, plus détaillée, et des manuels en ligne, il vous fournit toutes les instructions
nécessaires pour utiliser SmarTerm.

Ce guide explique comment installer SmarTerm dans la langue de votre choix (français, anglais,
allemand ou espagnol) et détaille les différentes options d’installation. Après avoir pris connaissance
de cette préface, passez à “Installation de SmarTerm” pour obtenir les instructions sur la manière
d’exécuter le programme d’installation.

Pour des informations sur l’Administrator Toolbox, notamment la création de profils et de serveurs de
profils ou le déploiement de SmarTerm pour les utilisateurs réseau, consultez la publication System
Administrator Guide (en anglais uniquement).

Support technique et informations
Si vous rencontrez des difficultés en utilisant SmarTerm, prenez connaissance de l’aide en ligne et de
la documentation. Si les problèmes persistent, appelez l’équipe de support technique d’Esker.

Avant d’appeler le support technique :

• Munissez-vous de votre numéro de licence : vous le trouverez dans la carte d’enregistrement du
logiciel qui accompagne votre produit. (Si vous avez entré le numéro en cours d’installation,
sélectionnez Aide > A propos.)

• Vous devrez sans doute fournir des informations détaillées concernant le matériel et les logiciels de
votre ordinateur. Une bonne connaissance de Windows, ainsi que des informations sur la
configuration de votre PC et la manière dont vous utilisez SmarTerm seront nécessaires.

• Isolez le problème autant que possible. Se produit-il lorsque vous tapez une certaine séquence de
touches ou après une opération quelconque ? Il est très utile de rédiger une brève description des
étapes qui mènent à ce problème : cela nous permettra de mieux le cerner.

• Restez à proximité de votre PC lorsque vous nous appelez. Il est en effet fort possible que nous vous
demandions d’exécuter quelques tests sur l’ordinateur.
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Installation de SmarTerm

SmarTerm est un ensemble intégré d’applications Windows qui mettent votre système en ligne grâce
aux méthodes de connectivité les plus populaires actuellement. SmarTerm est un produit multilingue
qui vous permet de travailler dans la langue de votre choix—allemand, anglais, français ou espagnol—
vous pouvez changer de langue sans avoir à vous déconnecter de l’hôte ou à quitter SmarTerm.

Ce chapitre vous guide tout au long de l’installation de SmarTerm.

Configuration requise
SmarTerm tourne sur tout système disposant des éléments matériel et logiciel suivants :

• Windows 7 32-bit ou 64-bit/Windows 8 ou 8.1 32-bit ou 64-bit/Windows Server 2008
R2/Windows Server 2012 ou 2012 R2, avec les derniers Service Packs ;

• matériel minimum requis par le système d'exploitation ;

• 128 Mo de RAM minimum ;

• résolution d'écran définie à 800 x 600 au moins, avec 256 couleurs ;

• matériel et logiciel de communication appropriés, tels qu’un port série ou modem, si vous prévoyez
d’utiliser une connexion série directe ou une connexion via modem ;

• la pile TCP/IP Windows, si vous prévoyez d’utiliser la méthode de connexion Telnet ou FTP ;

• client Microsoft Host Integration si vous prévoyez de supporter cette méthode de connexion ;

• Adobe® Reader pour lire les manuels. Vous pouvez télécharger ce logiciel depuis le site Web
d’Adobe ;

• 60 Mo d’espace disque disponible pour installer tous les composants et modules de langue.

Avant l’installation
Lisez attentivement les sections suivantes pour déterminer les étapes à effectuer avant d’exécuter le
programme d’installation pour installer SmarTerm.

Ayez votre numéro de série à portée de main
Le programme d’installation vous invite à entrer vos nom, et numéro de série pour le produit que vous
avez acheté. (Pour afficher votre numéro de série après l’installation, sélectionnez simplement Aide>A
propos de.) Vous devez inscrire SmarTerm pour obtenir un numéro de série.
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Quittez tous les autres programmes Windows
Pour faciliter autant que possible la procédure d’installation, désactivez tout programme exécuté en
arrière-plan, tel que :

• des applications

• des programmes anti-virus.

Options multilingues
Vous pouvez exécuter le programme d’installation en allemand, en anglais, en français ou en espagnol.
La langue que vous choisirez deviendra la langue par défaut lors de l’exécution initiale de SmarTerm.

Notez également que le programme d’installation installera toujours le module anglais, mais que vous
pouvez également installer les modules français, allemand et/ou espagnol. Les langues que vous
choisissez d’installer seront disponibles lors de n’importe quelle session de connexion à un hôte. Le
changement de langue est dynamique ; ceci signifie que vous pouvez initialiser une session en français
puis passer à l’allemand sans vous déconnecter de l’hôte ni même quitter SmarTerm. Les changements
de langue affectent les menus et boîtes de dialogue. L’aide en ligne est disponible en anglais
uniquement.

Type d’installation
Vous avez le choix entre deux types d’installation : Complète et Personnalisée. L’installation complète
installe toutes les fonctionnalités de SmarTerm, sauf l’Administrator Toolbox ; elle est recommandée
lors de votre installation initiale. L’installation personnalisée permet de sélectionner individuellement
les composantes SmarTerm à installer.

Remarque:
Pour installer l’Administrator Toolbox, choisissez Installation personnalisée, puis sélectionnez Outils
d’administration.
Pour installer SmarTerm dans un répertoire autre que le répertoire par défaut, choisissez Installation
personnalisée et cliquez sur le bouton Modifier. Entrez ensuite le chemin que vous voulez utiliser.

Exécution du programme d’installation
Observez les étapes suivantes pour exécuter le programme d’installation :

1. Insérez le CD dans le lecteur de CD-ROM et choisissez Install SmarTerm à partir de la fenêtre du CD
Browser.

Remarque:
Si la fonction d’exécution automatique est désactivée ou non disponible, exécutez autorun.exe à partir
du répertoire racine du CD.

2. Sélectionnez la langue d’installation.
3. Répondez aux invites affichées par le programme d’installation.

Si les valeurs proposées par défaut ne vous conviennent pas, tapez de nouvelles valeurs ou
sélectionnez une valeur dans les zones de liste ou les cases à cocher des boîtes de dialogue que vous
obtenez. Dans le doute quant à la réponse à fournir à une invite, consultez l’aide en ligne pour obtenir
des informations détaillées sur les choix disponibles, ou simplement validez les options par défaut.
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Remarque :
Les fichiers de configuration sont enregistrés pour l'utilisateur spécifique dans son dossier de
documents et de paramètres.
Le services des licences Esker requis contrôle le nombre d’instances de SmarTerm exécutées sur un
réseau par la publication chaque 15 minutes des informations de licence, via le port UDP 47474.
Pour afficher les paramètres avancés du programme d'installation, lancez Smarterm.exe avec l'option
ADVANCEDSETUP=1 (reportez-vous au System Administrator Guide). Cela vous permet de spécifier
si les utilisateurs partagent un emplacement de fichiers commun et/ou d'entrer un serveur de profils.

Actualiser SmarTerm de la version d'évaluation à la
version sous licence
Si vous achetez une copie de SmarTerm au service des ventes d'Esker ou auprès de votre revendeur,
vous pouvez utiliser l'utilitaire de gestion des licences, Esker Licensing Administration, pour passer de
votre version d'évaluation à une version permanente autorisée de SmarTerm. Pour cela :

1. Sélectionnez Démarrer > Programmes > SmarTerm > Utilitaires > Esker Licensing Administration.
2. Mettez en surbrillance le produit SmarTerm que vous désirer actualiser.

3. Cliquez sur le bouton Modifier les infos de sérialisation .
4. Entrez le nouveau numéro de série et le code d'activation, puis cliquez sur OK.

Vous pouvez maintenant exécuter votre copie permanente autorisée de SmarTerm.

Mettre à jour les fichiers personnalisés
Vous pouvez utiliser les fichiers personnalisés que vous avez créés en utilisant la version 6.0 ou
ultérieure d’un produit SmarTerm avec cette nouvelle version de SmarTerm. Les fichiers personnalisés
des versions 7.0 ou ultérieures de SmarTerm sont tous définis pour l’utilisation avec cette version—pas
de conversion de fichier requise. Utilisez simplement les fichiers tout comme vous l’avez fait pour ces
versions de SmarTerm. Ne perdez pas de vue les quelques règles suivantes lorsque vous mettez des
fichiers personnalisés à jour :

• Conservez une version archivée de tous vos anciens fichiers. Ceci implique de procéder à une copie
de sauvegarde de ces fichiers sur un serveur de réseau ou sur disquette/CD-ROM. SmarTerm crée des
copies de sauvegarde de certains fichiers mais il est conseillé d’archiver vos propres copies au cas où
vous auriez besoin de réutiliser vos anciens fichiers.

• Les conversions s’opèrent localement sur un PC. Si vous prévoyez de permettre aux utilisateurs
réseau d’accéder aux fichiers convertis, testez-les localement et copiez-les dans un dossier sur le
serveur réseau.

• La plupart des conversions s’opèrent automatiquement mais vous devrez copier les anciens fichiers
aux emplacements de fichier par défaut appropriés.

Mettre à jour les fichiers de session (.STW)
1. Démarrez SmarTerm, si ce n’est pas déjà fait.
2. Déroulez le menu Fichier.

La liste des fichiers .STW disponibles apparaît.

3. Sélectionnez un fichier .STW ; le fichier est converti dès que vous le sélectionnez.
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Dès que la liste apparaît, vous avez converti tous vos fichiers de session. Au cours de cette conversion,
SmarTerm crée une copie des fichiers .STW originaux et transforme leur extension en .BAK. Les
fichiers convertis sont transcrits en tant que fichiers .STW.

Remarque:
Après avoir testé les nouveaux fichiers de session pour vous assurer de la réussite de la conversion,
nous vous recommandons de supprimer les fichiers .BAK qui ne seront plus utilisés par SmarTerm.

N’oubliez pas
Si l’ancien fichier .STW utilisait un script de connexion (.psl), il est converti au nouveau langage de
macros et incorporé dans le nouveau fichier de session. (N’oubliez pas que les fichiers .PSL doivent se
trouver dans le dossier \Macros.)

Si vous disposiez d’un fichier .STW qui se connectait à un hôte via un modem, il sera converti au type
de connexion Série directe. Vous devrez donc créer un nouveau fichier .STW à utiliser avec un
modem. (La version 7.0 ou ultérieure de SmarTerm utilise l’interface TAPI de Microsoft, plutôt que
l’interface SmarTerm propriétaire de nos anciens produits.)

Les paramètres de la boîte de dialogue Préférences des produits antérieurs à la version 6.0 ne sont pas
convertis au nouveau format .STW.

Mettre à jour les fichiers de clavier (.KBO)
Remarque:
Si vous convertissez des fichiers de mappes de clavier supplémentaires TN3270, vous devez remplacer
l’extension .KB2 par .KBO avant la conversion au nouveau format SmarTerm.

1. Démarrez SmarTerm, si ce n’est pas déjà fait.
2. Sélectionnez Outils > Mappes de clavier.

La liste des mappes de clavier disponibles et des anciens fichiers .KBO apparaît.

3. Sélectionnez un fichier de mappe de clavier puis cliquez sur Edition.
4. Sélectionnez Fichier > Enregistrer.

Dès que vous l’enregistrez, l’ancien fichier .KBO est converti au format de la version 8.0. Lors de cette
conversion, SmarTerm crée une copie des fichiers .KBO originaux et remplace l’extension par .BAK.
Les fichiers convertis sont transcrits en tant que fichiers .KBO.

Remarque:
Après avoir testé les nouvelles mappes de clavier pour vous assurer de la réussite de la conversion,
nous vous conseillons d’éliminer les fichiers .BAK qui ne seront plus utilisés par SmarTerm.

Que faire ensuite ?
Pour des informations sur l’Administrator Toolbox, notamment la création de profils et de serveurs de
profils ou le déploiement de SmarTerm pour les utilisateurs réseau, consultez la publication System
Administrator Guide (en anglais uniquement).
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Prefacio
Esta guìa Para comenzar le ayudará a instalar SmarTerm en su PC. Esta guìa, junto con el sistema de
ayuda en lìnea más detallado y con los manuales en lìnea, le ofrecerá todo lo que necesita para utilizar
SmarTerm.

Esta guìa proporciona una serie de instrucciones para la instalación de SmarTerm en el idioma que
usted elija (alemán, español, francés o inglés) y ofrece unas pautas generales para la instalación. Una
vez leìdo este prefacio, pase a la “Instalación de SmarTerm”, donde encontrará instrucciones para
ejecutar el programa de instalación.

Para obtener información sobre Administrator Toolbox, incluida la creación de perfiles y servidores de
perfiles, la ejecución del Asistente de instalación automatizada, o el despliegue de SmarTerm para
usuarios de red, consulte la guìa de administración de sistemas: System Administrator Guide (sólo en
inglés).

Información y apoyo técnico
Si tiene problemas con SmarTerm, consulte la ayuda en lìnea y la documentación de SmarTerm. Si los
problemas persisten, llame al Departamento de apoyo técnico de Esker.

Antes de llamar al soporte técnico:

• Tenga a mano su número de licencia. Se encuentra en la tarjeta de registro que viene con el
producto. Si ha escrito el número durante la instalación, puede ver este número de licencia
seleccionando Ayuda>Acerca de.

• Recuerde que es posible que necesitemos información detallada acerca del hardware y del software
de su computadora, asì que será necesario tener conocimientos sobre Windows, la configuración de
su PC y el modo de utilización de SmarTerm.

• Intente aislar el problema al máximo. Determine si el problema se produce cada vez que introduce
una determinada secuencia de teclas o si tiene que realizar alguna acción previa. Escriba una breve
descripción de los pasos empleados para reproducir el problema: ayudará a ambas partes a aislarlo.

• Siéntese ante la computadora que le esté causando problemas y llámenos desde ahì. Es posible que
le solicitemos que ejecute algunas pruebas diagnósticas, que deberán realizarse en la computadora
que presenta el problema.
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Instalación de SmarTerm

SmarTerm es un conjunto integrado de aplicaciones Windows que puede utilizar en lìnea con los
métodos de conectividad más populares de hoy en dìa. SmarTerm es un producto multilingüe, con el
que puede trabajar en el idioma de su elección (alemán, español, francés o inglés) y que a la vez le
permite cambiar de idioma sin necesidad de desconectarse del host o de salir de SmarTerm.

En este capìtulo encontrará pasos detallados para la instalación de SmarTerm.

Requisitos de instalación
SmarTerm puede ejecutarse en cualquier sistema que tenga el hardware y software siguiente:

• Windows 7 32-bit o 64-bit/Windows 8 o 8.1 32-bit o 64-bit/Windows Server 2008 R2/Windows
Server 2012 o 2012 R2, con los últimos Service Packs instalados.

• El hardware mínimo requerido por el sistema operativo.

• 128 MB de RAM.

• Una resolución de pantalla configurada con al menos 800 x 600 con 256 colores.

• Software y hardware de comunicaciones adecuado, como un puerto en serie o un módem, en caso de
que desee establecer una conexión en serie directa o una conexión de módem.

• La pila TCP/IP de Windows, en caso de que desee utilizar el método de conexión Telnet o FTP.

• Cliente Host Integration de Microsoft si prefiere utilizar esto método de conexión.

• Adobe® Reader para leer los manuales en lìnea. Puede descargar este software del sitio Web de
Adobe.

• 60 MB de espacio libre en disco para instalar todos los componentes e idiomas.

Antes de la instalación
Lea los apartados siguientes para ver si tiene que realizar algún paso antes de ejecutar el programa de
instalación para instalar SmarTerm.

Tenga a mano su número de serie
El programa de instalación le solicita su nombre y el número de serie y su clave de activación del
producto que adquirió (para ver su número de serie tras la instalación, simplemente seleccione
Ayuda>Acerca de). Debe registrar SmarTerm para obtener un número de serie.
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Cierre de programas Windows adicionales
Para que el proceso de instalación sea lo más cómodo posible, cierre los programas que se estén
ejecutando en procesos de fondo como:

• Aplicaciones

• Programas antivirus

Opciones multilingües
Puede ejecutar el programa de instalación en alemán, español, francés o inglés. El idioma que
seleccione en el momento de la instalación será el idioma predeterminado cuando ejecute SmarTerm
por primera vez.

Asimismo, el programa de instalación siempre instalará los componentes en inglés, aunque también
puede instalar los componentes en alemán, español y francés. En cualquier sesión que utilice para
conectarse a un host, podrá utilizar cualquiera de los idiomas que haya instalado. El cambio de idioma
es dinámico, es decir, que puede iniciar una sesión en francés y cambiar a alemán sin desconectarse del
host o sin salir de SmarTerm. Los cambios de idioma afectan a los menús y a los diálogos. La ayuda en
lìnea está disponible sólo en inglés.

Tipo de instalación
Puede seleccionar dos tipos de instalación: Completa y Personalizada. La opción Completa instala
todas las funciones de SmarTerm excepto Administrator Toolbox, y es la recomendable en la primera
instalación. La Personalizada le permitirá seleccionar los componentes de SmarTerm que desee
instalar.

Nota:
Si desea instalar Administrator Toolbox, deberá elegir Personalizada y luego seleccionar Herramientas
de administración.
Para instalar SmarTerm en una ruta diferente de la predeterminada, elija la instalación Personalizada y
haga clic en el botón Cambiar. A continuación introduzca la ruta deseada.

Ejecución del programa de instalación
Siga los pasos siguientes para ejecutar el programa de instalación:

1. Introduzca el CD en la unidad de CD-ROM y seleccione Install SmarTerm en la ventana de CD
Browser.

Nota:
Si la función de ejecución automática está desactivada o no disponible, ejecute autorun.exe, que
hallará en el directorio raìz del CD.

2. Seleccione el idioma deseado para el programa de instalación.
3. Siga las indicaciones del programa de instalación.

Si no le gustan los valores predeterminados, escriba valores nuevos o seleccione un valor de los
cuadros de lista o de las casillas de verificación de un cuadro de diálogo. Si no está seguro de la
respuesta adecuada a una solicitud, consulte la ayuda en lìnea para obtener información detallada
acerca de las opciones, o simplemente acepte los valores predeterminados.
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Nota:
Los archivos de configuración se guardan cuando asì lo ordena el cliente en la ubicación de
configuración y de los documentos del usuario.
El Servicio de licencias de Esker obligatorio realiza un seguimiento del número de instancias de
SmarTerm que se están ejecutando en una red. Esto lo realiza transmitiendo la información de la
licencia cada 15 minutos a través del puerto UDP 47474.
Para mostrar los parámetros avanzados del programa de instalación, ejecute Smarterm.exe con la opción
ADVANCEDSETUP=1 (refiera al System Admnistrator Guide). Esa opción le permite especificar si los
usuarios comparten una ubicación de archivos común y/o si utilizan un servidor de perfiles.

Actualización de SmarTerm desde una copia de
evaluación hasta una copia con licencia
Una vez compre una copia de SmarTerm de un punto de venta o un distribuidor de Esker, puede
utilizar la utilidad Esker Licensing Administration para actualizar de una copia de evaluación de
SmarTerm a una copia con licencia.

1. Seleccione Inicio > Programas > SmarTerm > Utilidades > Esker Licensing Administration.
2. Resalte el producto SmarTerm que desea actualizar.
3. Haga clic en el botón Modificar información de serialización .
4. Introduzca el nuevo número de serie y la nueva serie de activación, y haga clic en Aceptar.

En ese instante podrá comenzar a ejecutar su copia con licencia de SmarTerm.

Actualización de archivos personalizados de
versiones anteriores
Puede utilizar archivos personalizados que haya creado usando un producto SmarTerm de la versión
6.0 ó posterior, con esta nueva versión de SmarTerm. Los archivos personalizados de las versiones 7.0
ó posteriores de SmarTerm están listos para usar con esta versión —no es necesario convertirlos.
Simplemente use los archivos de la misma manera que lo hizo en dichas versiones de SmarTerm. Hay
algunas observaciones que deben tenerse en cuenta al actualizar archivos personalizados:

• Mantenga un registro de todos sus archivos anteriores. Ello implica realizar copias de seguridad de
los archivos en una ubicación del servidor de red o bien en un disquete. SmarTerm crea copias de
seguridad de algunos archivos, pero lo mejor es que conserve sus propias copias, en caso de que
alguna vez tenga que utilizar los archivos anteriores.

• Las conversiones se realizan localmente en un PC. Si tiene la intención de que los archivos
convertidos estén disponibles para los usuarios de red, puede probarlos localmente y copiarlos en la
carpeta del servidor de red.

• La mayorìa de las conversiones se realizan automáticamente, pero tiene que copiar los archivos
anteriores en las ubicaciones correctas de archivos predeterminados.

Actualización de los archivos de sesión (.STW)
1. Inicie SmarTerm si aún no está en ejecución.
2. Despliegue el menú Archivo.

Aparecerá una lista de archivos .STW disponibles.
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3. Seleccione un archivo .STW. Se convertirá tan pronto como lo haya seleccionado.
Una vez haya aparecido la lista, habrá convertido todos los archivos de sesión. Durante la conversión,
SmarTerm realiza una copia de los archivos .STW originales y cambia la extensión a .BAK. Los
archivos convertidos se graban como archivos .STW.

Nota:
Después de comprobar los nuevos archivos de sesión para ver si la conversión se llevó a cabo
correctamente, es posible que desee eliminar los archivos .BAK, que SmarTerm ya no necesitará más.

Algunas observaciones
Si el antiguo archivo .STW usaba un archivo de inicio de sesión (.psl), ahora se convertirá al nuevo
lenguaje de macros y se integrará en el nuevo archivo de sesión. Recuerde que los archivos .PSL
tienen que estar en la carpeta \MACROS.

Si tenìa un archivo .STW conectado a través de un módem a un host, este archivo se convertirá al tipo
de conexión en serie directa. Deberá crear un nuevo archivo .STW para ser utilizado con un módem.
(SmarTerm utiliza la interfaz TAPI de Microsoft.)

Los valores del cuadro de diálogo Preferencias en los productos anteriores a la versión 6.0 no se
convierten al nuevo formato .STW.

Actualización de los archivos de teclado (.KBO)
Nota:
Si está convirtiendo los archivos de mapa de teclado adicionales TN3270, necesitará cambiar la
extensión .KB2 a .KBO antes de pasar al nuevo formato de SmarTerm.

1. Inicie SmarTerm, si todavìa no se está ejecutando.
2. Seleccione Herramientas>Mapas de teclado.

Aparecerá una lista de los archivos .KBO antiguos y de los mapas de teclado disponibles.

3. Seleccione un archivo de mapa de teclado y haga clic en Editar.
4. Seleccione Archivo>Guardar.

Cuando haya guardado el archivo .KBO antiguo, éste se convertirá al formato de la versión 8.0.
Durante la conversión, SmarTerm realiza una copia de los archivos .KBO originales y cambia la
extensión a .BAK. Los archivos convertidos se graban como archivos .KBO.

Nota:
Cuando haya probado los mapas de teclado nuevos y haya visto que la conversión ha sido correcta, es
aconsejable que elimine los archivos .BAK, que SmarTerm no vaya a utilizar más.

El paso siguiente
Para obtener información sobre la instalación de Administrator Toolbox, la creación de perfiles y de
servidores de perfiles o el despliegue de SmarTerm para usuarios de red, consulte la guìa de
administración de sistemas: System Administrator Guide (sólo en inglés).
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